
Getting Started Manual

PN: 02EM862706000 

Rev. A

© 2006 E-MU Systems

All Rights Reserved

E-MU World Headquarters

E-MU Systems

1500 Green Hills Road

Scotts Valley, CA  95066

USA

Europe 
Creative Labs (Ireland) Ltd
Ballycoolin Business Park
Blanchardstown, Dublin 15
IRELAND

Asia Pacific Africa, Middle East 

Creative Technology Ltd

31 International Business Park

Creative Resource, Singapore 609921

SINGAPORE

Japan

Creative Media K. K.

Kanda Eight Bldg., 3F 

4-6-7 Soto-Kanda

Chiyoda-ku, Tokyo 101-0021

JAPAN
E-MU Systems, Inc. i



Table of Contents

1 - Introduction & Installation ...............................1
Introduction .................................................................................... 1

Emulator X2 ...................................................................................... 2
Before you Begin… ........................................................................... 3

System Requirements ...................................................................... 3
Software Installation ........................................................................ 3

Programs installed ............................................................................ 3
Optimizing Your Computer for Emulator X2 ...................................... 4
SCSI and IDE Drive Tips and Considerations ....................................... 5

Setting up your Audio ..................................................................... 6
Setting up the Preferences ............................................................... 7

Audio Preferences ............................................................................. 8
MIDI ............................................................................................... 13
Controllers ...................................................................................... 16
Other Settings ................................................................................ 17

2 - Emulator Architecture ....................................19
A Modular System ......................................................................... 19

Bank ............................................................................................... 19
Preset Diagram ............................................................................. 24

Flexible Architecture ....................................................................... 25
Voices ............................................................................................. 25
The Sample ..................................................................................... 27

3 - Getting Started ..............................................29
Exploring the Tree ......................................................................... 29
Multisetup Page ............................................................................ 30

Changing Presets ............................................................................ 31
Adjusting the Controllers ................................................................. 32

Create Your Own Custom Bank ..................................................... 33
Load a New Bank .......................................................................... 33
Opening a Preset .......................................................................... 34
ii Emulator X2 - Getting Started



Examine a Voice ............................................................................38
Examine the Samples .....................................................................41

Using DSP ....................................................................................... 43
Save and Save As ............................................................................ 46

The Librarian .................................................................................47
Much More! .................................................................................... 49

Index ..................................................................51
E-MU Systems, Inc. iii



iv Emulator X2 - Getting Started



1 - Introduction & Installation

Introduction
The Emulator X2 Software Sampler is a professional software sampler and 
synthesizer based on the Emulator and Proteus series of hardware instru-
ments. The engineers and designers at E-MU Systems have brought their 
years of experience and expertise to create the most comprehensive and 
flexible software instrument ever.

Important!
The complete Emulator X2 manual is available in .pdf format on one of the 
included CD-ROMs.

• Install your EMU audio interface BEFORE installing and running 
Emulator X2.

Important 
Le manuel complet de l’Emulator X2 est disponible au format .pdf, sur des 
CD-ROM fournis.

• Installez l’interface audio EMU AVANT d’installer et de lancer 
l’Emulator X2.

Wichtig
Das komplette Emulator X2 Handbuch ist im PDF-Forma tauf einer der 
beiliegenden CD-ROMs verfügbar.

• Installieren Sie Ihr E-MU Audio-Interface BEVOR Sie Emulator X2 
installieren un starten.
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Emulator X2
Emulator X2 allows quick and easy creation of multitimbral setups on up to 
64 different MIDI channels. Other features include the following:

Emulator X2 allows the serious synthesist and programmer to literally 
design their own instruments using the renowned Emulator 4 and Proteus 
synthesis architecture.

• Sound Engine supports RAM and streaming playback

• Integrated effects processors

• Drag and drop sample, voice and preset selection

• Phase Locked Stereo signal path

• Ultra High Precision Pitch Interpolation (user selectable) 

• High Voice Polyphony (system dependent)

• Real-time controllers for all important control points

• TwistaLoop analyzes audio and allows editing with multiple loops & regions

• SynthSwipe sampling tool automatically samples any MIDI instrument

• Automated Sampling, pitch detection and preset creation

• 55 different filter types including multi-pole resonant filters, phasers, 
flangers, vocal filters and morphing filter designer.

• Extremely powerful, yet easy to use voice and sample zones allow cross-
fading by position, velocity or real-time controller up to 128 layers deep.

• Three multi-stage envelopes, three 64-stage function generators, two lag 
processors and two multi-wave LFO’s per voice.

• A complete collection of sample-based DSP functions including: transform 
multiplication, time compression/expansion, and sample rate conversion.

• Multiple solo modes and assignment groups let you simulate the playing 
response of physical instruments and classic synthesizers.

• 36 patchcords per voice allow you to get as complex as you want when 
building instruments.
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Before you Begin…
You should have a good working knowledge of your computer’s operating 
system. For example, you should know how to use the mouse, standard 
menus and commands. You should also know how to cut, copy, paste, 
open and close files.

System Requirements
To use Emulator X2 you will need at least:

• Pentium III 1GHz or equivalent CPU 
(P4, 2 GHz or faster recommended)

• 512 MB RAM (1 GB DDR or greater recommended)

• 7200 RPM hard disk, preferably with an 8MB cache

• Windows 2000 or XP

Software Installation

Programs installed
• Emulator X2 Software Sampler application

• Emulator X2 VSTi

• Emulator X Converter

• Emulator X Factory Sound Banks

1. Insert the CD labeled “Software/Manual Installation CD-ROM” into 
your CD-ROM drive. If Windows AutoPlay mode is enabled for your 
CD-ROM drive, the CD starts running automatically. If not, from your 
Windows desktop, click Start  Run and type d:\ctrun\ctrun (replace 
d:\ with the drive letter of your CD-ROM drive).

2. The installation splash screen appears. 
Follow the instructions on the screen to complete the installation.

3. When prompted, restart your computer.

• The Emulator X applications have been installed inside “Creative 
Professional/Emulator X/Program Files.”
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4. Look for any “ReadMe” files in the Emulator X folder or in the Start 
menu and read these before continuing. The readme files may contain 
important last minute information that didn’t make it into this manual.

5. Remove the Emulator X application disk from the CD-ROM drive.

Install the Emulator X Sound Banks

6. Locate “Sound Disk 1”and insert it into the CD-ROM drive. This disk 
contains four sound banks including the Proteus Composer X bank 
used in the tutorials.

7. If Windows AutoPlay mode is enabled for your CD-ROM drive, the 
installer begins running automatically. Otherwise, double-click the 
“Setup” icon to begin extracting the bank files. 

8. Follow the onscreen instructions to install the bank on your hard disk. 
The Factory Sound Banks are installed inside “Creative Professional\ 
Emulator X\Sound Banks” by default.

9. You can install the other sound bank disks now or at a later time.

10. Launch the Emulator X program by double clicking the Emulator X icon 
on the desktop or by selecting the Emulator X item from the Start menu.

Register your Software
Please register your software today to guarantee uninterrupted use.

Optimizing Your Computer for Emulator X2
The following suggestions can help you configure your Windows computer 
for optimal performance. Since systems vary, we recommend that you note 
the original settings of any system parameters you alter so that you can 
restore them in the event that unexpected problems occur.

• Consider dedicating a computer as your audio workstation. This 
computer can be optimized for best audio performance.

• If possible, avoid assigning slower devices to the IDE controller 
used by your audio drive.

• Get the fastest hard disk drive you can afford, as this is the single 
most important component affecting Emulator X performance. 
Many drives now offer an 8MB data buffer to improve performance.

• Defragment your hard drive often.
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• Perform a “clean” install of your operating system with only the 
minimum components and programs installed. 

• Use the System Restore feature of Windows XP or other restoration 
program such as Norton Ghost® or Roxio Go Back® to keep your 
system uncluttered and fast.

SCSI and IDE Drive Tips and Considerations
When considering the purchase of a new SCSI or IDE drive for use with 
Emulator X, make sure that the new drive supports a sustained data transfer 
rate of at least 1.6 megabytes per second. While it is impossible to reliably 
calculate the needs of your computer's operating system — which must be 
considered in addition to Emulator X’s requirements — you can get an 
approximate idea of the necessary speed of your hard disk drive based on 
the bit depth and number of voices you need.

• Regularly check your hard drive for fragmentation and de-fragment 
the drive when necessary. Your drive will operate most efficiently 
when it’s not fragmented.

• If possible, use a two-drive system: one for audio, one for your 
system.

  Data Transfer Rate Chart
16 bits 44.1 k sample rate 86.2 k per Channel per second

48 k sample rate 93.8 k per Channel per second

24 bits 44.1 k sample rate 138 k per Channel per second

48 k sample rate 150 k per Channel per second
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Setting up your Audio
Before you can start making music, you have to establish a connection 
between Emulator X and your audio output hardware. This is done by 
selecting a software driver that makes this connection between hardware 
and software.

1. Select the Preferences screen from the menu bar.

2. In the Audio section of the menu, select E-MU ASIO if using an E-MU 
Digital Audio System. Select E-MU USB|0202 or USB|0404 if using an 
E-MU USB interface

3. After running Emulator X, you may want to adjust the Audio Prefer-
ences for optimum performance on your computer system. See Audio 
Preferences on page 8.

4. If for some reason you want to use hardware that doesn’t support 
ASIO, select the DirectSound driver. For Emulator X to communicate 
with your sound card, you need to have Microsoft DirectSound 
installed on your computer and there must be a DirectSound driver 
installed for your audio hardware. 
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Setting up the Preferences
The preferences menu contains a variety of important controls used to 
configure Emulator X for your audio hardware and to customize the 
controls to suit the way you work.

� To Access the Preferences Menu

1. Select Preferences from the Options menu and this screen appears.

2. The preferences menu is divided into four main groups. Click on the 
tab heading to select one of the four sets of controls.

Audio Disk Streaming Controls, Audio Hardware Setup & Pitch Shift 
Algorithm selection, ASIO Control Panel.

MIDI MIDI Inputs Channels 1-16 & 17-32, 33-48, 49-64 IntelliEdit, 
and Receive/Ignore Program Changes, Internal/External 
Tempo Source select, Velocity Curve, Volume Curve, Volume 
Sensitivity, Preset Tempo Channel.

Controllers This section allows you to set up the MIDI Continuous 
Controllers you want the Emulator X to receive.

Other This group contains several miscellaneous controls: Load last 
bank at startup, Select preset on active channel when editing 
in multimode, Clear clip indicators after 10 seconds, Expand 
tree items when selected, Knob tracking, Recording Directory, 
External Audio Editor, Undo.
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Audio Preferences

Streaming
When you load an Emulator X bank with streaming on, you are not actually 
loading the sample files themselves into your computer’s RAM. Only the 
preset information and the first few seconds of the sample are loaded. The 
rest of the sample data is taken directly from the hard disk when needed.

This streaming technique makes fast loading times possible even when 
using huge banks that would clog a RAM-based sampler. Multi-layer, 
minute-long, stereo samples on each key are no problem for Emulator X. 
Sample streaming is not new. It was originally developed for hard disk 
audio recorders so that fast punch-ins and punch-outs could be achieved.

You have the option to enable or disable streaming audio. If streaming is 
turned off, the Emulator X loads (or attempts to load) the entire bank into 
your computer’s RAM.

Tip: If you get an error message when trying to open a file, the file may be too 
large to fit into RAM. Turn streaming on.

If streaming is so great, why would you ever want to turn it off? Well, if 
you’re using your computer as an audio workstation, performing multiple 
simultaneous functions, sooner or later, you’ll exceed your computer’s 
CPU, memory or disk access resources. Sample streaming makes very heavy 
demands on your hard disk. If you’re recording other audio tracks, using 
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multiple software plug-ins and playing Emulator X with a lot of voices, you 
may run into a disk access bottleneck. By disabling streaming and loading 
the bank into your unneeded RAM, your hard disk can be reserved for more 
critical operations.

Pre-roll 
This important control allows you to set how many seconds of each 
sample should be loaded into RAM when the bank is loaded. This setting 
greatly influences the performance of Emulator X when streaming is on. 
The setting you choose depends on: the number of samples you want to use 
and the amount of RAM in you want to dedicate to Emulator X.

Decrease Pre-roll time for fast load times when auditioning sounds and 
creating new banks.

Increase pre-roll time when you’re playing sounds or dense sequences.

The smaller the pre-roll, the more disk access will be required for sustained 
sounds. Frequent disk access can overtax your computer system depending 
on it’s speed and the number of other disk dependant applications you 
have running. Large pre-roll times will improve polyphony and perfor-
mance at the expense of system RAM and slower bank loading. If you set 
the pre-roll high enough, the entire bank will be loaded into RAM and no 
disk streaming will occur.

Sample Buffers
This control allocates the amount of RAM that will be set aside for Emulator 
X (in other words, the number of complete samples that can be kept in the 
RAM cache). As samples are played, they are loaded from the hard disk into 
RAM. If you play those samples again, they don’t have to be reloaded if they 
are already in RAM. This control sets the size of the RAM cache relative to 
the size of the bank. A higher number lowers disk access at the expense of 
RAM.
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� To Optimize the Performance and Polyphony of your System:

The polyphony of the Emulator X is dependent on a variety of factors 
including:

Begin by choosing 44.1kHz or 48.kHz as your output sample rate.

The software-based filters can eat up CPU cycles and reduce polyphony.

Synthesizer parameters also use CPU cycles. When creating presets, feel free 
to use modulation cords as needed, but don’t leave cords half connected if 
you aren’t using them since these patch settings waste CPU cycles. Turn off 
both the source and destination of unused cords.

• The Pre-roll setting (if streaming is enabled).

• The Sample Buffers setting (if streaming is enabled).

• The CPU Cap setting.

• The bit depth of your samples —16 or 24 bits (24 bits = fewer voices)

• The sample rate of the audio hardware—44.1kHz, 48kHz, 96kHz. 

• The speed of your computer—CPU speed, RAM and hard disk access time.

Cost of Filters on Voice Count

No Filter No additional CPU load.

2nd Order Additional CPU load comparable to playing another 1/2 sample.

4th Order Additional CPU load comparable to playing another 3/4 sample.

6th Order Additional CPU load is comparable to playing 1 more sample.
(polyphony is divided by 2)

12th 
Order

Additional CPU load comparable to playing 2 more samples. 
(polyphony is divided by 3)
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Audio Setup
These are audio parameters related to Emulator X and your sound card.

Type
You have a choice to use either DirectSound or ASIO audio drivers. If you 
have another high quality sound card installed in your system, it will be 
shown in this field. ASIO (Audio Stream Input/Output) is a cross-platform, 
multi-channel audio transfer protocol and supports 16 or 24-bit data width. 

To use Emulator X with an E-MU audio interface, 
you MUST select the proper E-MU ASIO driver.

Selecting DirectSound uses the audio output device specified in the control 
panel of your computer. In general, using DirectSound is not recom-
mended because of speed and latency issues.

Buffer Size
This control sets the number of sample periods between updates of the 
synthesizer parameters. The buffer size can adjusted according to speed of 
your computer’s CPU. A faster CPU can handle a lower buffer size. The 
default setting is 128 sample periods, a good compromise of performance 
to CPU usage. An asterisk (*) next to a buffer size in the drop-down menu 
indicates the optimal buffer size for your ASIO Buffer Latency settings.

Use Optimal Buffer Size
When this box is checked, the Emulator X will choose the best buffer size 
based on the ASIO Buffer Latency setting. You should normally leave this 
feature enabled for best audio performance.

Sample Rate
This control sets the output sample rate of the Emulator X, and will always 
match sample rate of your sound card. The default setting is 44.1kHz.

CPU Cap
This control sets percentage of CPU resources that will be used by Emulator 
X and consequently the maximum number of samples that can be played at 
the same time. Depending on the design of the preset, a single Emulator X 
voice may contain multiple samples which play simultaneously. The 
maximum setting is 80% CPU usage. If you hear notes being “stolen” in 
your sequence or as you play the keyboard, or if the disk meter readout at 
the bottom of the window goes into the red, increase the value of this 
control. If you have other applications running, you may want to reduce the 
setting of this control to free up more CPU for them.
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Headroom/Boost
Headroom is the amount of dynamic range remaining before clipping 
occurs. The headroom setting can be a bit confusing because the higher the 
number, the lower the volume.

The amount of headroom is adjustable from 12 dB to -30 dB in 1 dB incre-
ments. A headroom setting of -15dB provides the hottest output level, (and 
the highest signal to noise ratio) but may produce “clipping” if too many 
notes are played at once. The default headroom setting is -7 dB, which 
maintains an excellent signal to noise ratio while keeping a reasonable 
amount of headroom in reserve. If you hear the signal clipping or breaking 
up, increase the amount of headroom. In practice, you can think of this 
control as adjusting the control range of the Master Volume control.

Ultra-High Precision Interpolation Button
This button allows you to select between E-MU’s ultra-high precision pitch 
shifting algorithm or a lower quality pitch shifting scheme which uses fewer 
CPU resources.

If you are using presets with a sample placed on every key, you can switch 
high precision off to free up CPU with no penalty in audio quality. No pitch 
shifting is occurring anyway. High quality pitch shifting is only needed 
when you are playing presets which have a few samples mapped across the 
entire keyboard. In this case, the Emulator X shifts the pitch of the available 
samples to fill in the keyboard.

ASIO Control Panel
This button brings up the E-MU ASIO control panel which allows you to set 
the ASIO buffer latency in milliseconds. This important setting determines 
how fast notes will sound after you play them. If this time is too long, 
(<10mS) the keyboard response will feel slow and sluggish. If set too fast, 
however, you will hear the sound break up and crackle when you play too 
many notes. Experiment to find the setting that gives the best performance 
on your computer.

VST Output Buses
This control is only active in the Emulator X VSTI application. This setting 
allows you to add additional VST buses. Emulator X channel outputs can be 
assigned to VST buses in the Multisetup, Output field. These outputs are 
sent to the VST Mixer in your recording application. You must restart the 
VSTI for the changes to take effect.
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MIDI
This group of preferences allow you to set up the MIDI inputs, adjust the 
master MIDI volume and velocity curves and turn the “IntelliEdit” feature 
on or off.

MIDI Inputs

Channels 1-16, 17-32, 33-48, 49-64
The Emulator X can respond to 64 MIDI channels at once. Since there can 
be only 16 MIDI channels per MIDI cable (or input) four inputs are 
provided. Set the MIDI Inputs to match up to four outputs from your MIDI 
interface or sequencer. If you don’t need 64 channels you can turn either 
input off.  Note: There are 16 MIDI channels per instantiation of the 
Emulator X VSTi.

IntelliEdit
This control allows you to set the MIDI device for IntelliEdit. Selecting 
“None” disables the feature.

When editing sample key ranges or editing voices sit is convenient to select 
the key position by simply playing your MIDI keyboard. IntelliEdit lets you 
selectively edit key ranges using the keyboard when you need to, but blocks 
keyboard editing when you may not want it, such as when your keyboard is 
playing in the background. Here’s how it works.
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� To Use IntelliEdit:

1. Make sure IntelliEdit is set to the same MIDI port your keyboard is 
using.

2. In one of the Voices and Sample Zones screens such as “Key Window”, 
position the cursor inside one of the Key Range fields (Low or High).

3. Press and hold, Ctrl+Alt on your computer keyboard.

4. Play your MIDI keyboard. The key range will be edited.

5. In the Voice Edit window, holding Ctrl+Alt lets you select voices for 
editing. If more than one voice is assign to the key, the voices will cycle 
around with repeated pressing of the same key.

6. To select multiple voices, you must use the Group feature.

Receive Program Changes
This button selects whether or not MIDI Program Change messages from 
your MIDI controller or sequencer will be received or ignored by the 
Emulator X. Depress the button to receive program changes.

External Tempo Source
This button selects between internal tempo clock or MIDI clock as the 
tempo source. The Emulator X uses a global master tempo for Tempo-based 
Envelopes, Tempo-based LFOs, clock modulation, and TwistaLoop. When 
this button is pressed, MIDI clock will be used for the global tempo and the 
tempo control in the Multisetup window will be disabled.

Important: If External Tempo Source is set to external, the tempo control in the 
Voice Editor will be “greyed-out” and non-functional.

Preset Tempo Channel
The tempo of the Emulator X can be specified in the preset so that selecting 
a preset on a specific MIDI channel changes the tempo. This option selects 
the MIDI channel whose preset will be used for Tempo Control. This allows 
the proper tempo to be set when a Tempo-based or Twistaloop preset is 
selected.
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For example, suppose you have this field set to channel 1 and the preset on 
MIDI channel 1 has its Tempo Control set to 122.22 BPM. When the bank 
is loaded, the Tempo will be set to 122.22 BPM. If you change the preset on 
channel 1, the tempo will change to follow the “Set Global Tempo” setting 
in the new preset.

If the preset on the Preset Tempo channel has its Tempo Control set to 
“Off”, (or if this option is set to “Off”) no tempo change occurs when the 
preset is selected.

MIDI Response
These controls allow you to customize the MIDI response of the Emulator X 
to match your MIDI Controller or other instruments.

Velocity Curve
Incoming velocity values can be scaled by one of 24 curves to better adapt 
to your playing style or MIDI controller. Selecting “linear” leaves the 
velocity data unaltered. The shape of the selected curve is displayed in the 
window. Select the curve that works best for you.

Volume Curve
This is an adjustment to help match MIDI controller #7 volume response to 
other manufacturers’ equipment. Three curves are provided: Linear, Inverse 
Square or Logarithmic. The action of this control is displayed in the 
window.

Volume Sensitivity
This control allows you to modify the response curve for MIDI continuous 
controller #7 (Volume). This allows you to match the Emulator's response 
to other manufacturers’ equipment. Low numbers compress the volume 
control range, raising the volume level at lower controller #7 values.
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Controllers
This is where you set up which MIDI Continuous Controllers the Emulator 
X will receive. Match these controls to the MIDI continuous controller 
numbers that your keyboard or sequencer transmits. What the controllers 
actually control, is programmable in each preset.

As you can see, MIDI Continuous Controller numbers are assigned to 
letters (A-P) or labels (Pitch, Mod, Pressure, Pedal, etc.) in this screen. 
When programming a preset, these letter or name labels can be assigned to 
control various parameters such as filter frequency or attack time.

The name labels such as pitch and mod wheels are so commonly used that 
they have their own assigned name, but these can also be freely assigned in 
any way you choose.

If you’re just getting started, it’s probably best to use the default settings. 
Press the “Use Default” button to restore the default settings which are 
shown above.
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Other Settings

Startup

Load last bank
This feature automatically loads the last bank you had loaded whenever 
you start the Emulator X application.

Interface

Select preset on active channel when editing in Multimode
When checked, selecting a preset for editing in the Tree selects that preset 
on the active channel in the multisetup. This is what you want if you’re 
editing preset and playing a MIDI keyboard.

If you’re playing back a multi-timbral sequence and want to make a quick 
edit to a preset, you might want this feature Off so as not to alter your multi-
setup.

Clear clip indicators after 10 seconds
This feature automatically clears the main output meter clip indicators. If 
this function is set to Off, the clip indicators will stay on until you manually 
click on them.
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Expand tree items when selected
If this option is checked, selecting presets from the Tree will automatically 
open the selected preset for editing. When unchecked, selecting presets 
from the Tree will select the preset for playing, but not open it for editing.

Knob Tracking
This control allows the rotary knobs to be manipulated with either Rotary, 
Horizontal, or Vertical motion. The setting affects all rotary controls.

Paths

Recording and temp file directory
This option allows you to choose the location where new samples will be 
stored when sampling.

External audio editor
This option allows you to set the location of an external audio editor. The 
External Audio Editor is selected from the Sample Edit menu or the toolbar. 

 When the External Editor is selected, the current sample opens in the 
editing application you have selected. When you Save the edited sample in 
the external editing application, it is automatically transferred back to the 
Emulator X. You even have the option to Undo the external edit.

Undo

History size
The maximum number of stored undo steps.

Clear history when saving
Clears all undo history when you save a bank. If you have this box 
unchecked, you can undo even when you save and re-open a bank.

Clear now
Clears the undo history immediately.
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2 - Emulator Architecture

This chapter contains important background information about the organi-
zation of the various modules of the Emulator X. Although this chapter 
doesn’t contain any hands-on tutorials, this information is vital to your 
understanding of this ultra powerful instrument. Read This!

A Modular System
You can think of the Emulator X as a collection of sound organizing 
modules, all contained within the current bank. The following is a brief 
description of the five main elements of the Emulator X hierarchy starting 
from the largest element, the Bank.

Bank
Before you can play Emulator X, you load a Bank of presets. The bank 
contains all the sounds you wish to use in a particular sequence or perfor-
mance. If you need additional sounds, they can be added by simply 
dragging and dropping them into the bank from the system or library. 
Unneeded sounds can likewise be removed from the bank. When loading a 
bank, the Emulator X only loads a small portion of the digital samples and 
so bank load time is greatly reduced.

Saving
The bank retains data only for as long as your computer is plugged in and 
turned on. Of course, we don’t expect you to leave the thing on all the time, 
which brings us to the subject of saving data.

Saving the bank to a hard disk permanently stores data so that even after 
turning off your computer, the disk stores a record of your work.

IF YOU DO NOT SAVE A BANK, ANY CHANGES YOU HAVE MADE WILL 
BE LOST WHEN YOU TURN OFF THE COMPUTER!

Do not wait until the end of a session to save. Save your work periodically 
in case of power failure or some other unforeseen circumstance that might 
erase the computer’s memory. Hard disks and computers are not infallible.
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All hard disk banks should be backed up periodically to another hard disk 
or other media. Should you improve the preset or sample later, you can 
always replace the original with the revised version. And if something goes 
wrong, the original will still be available to save you the ordeal of starting 
from scratch.

When you choose Save, (as opposed to Save As) only the edited presets, 
voices and samples will be written, saving time and memory.

When you choose “Save As” from the file menu, the entire bank—presets, 
voices and samples—are re-written to the hard disk. This method, although 
somewhat wasteful of memory, ensures that all your samples remain 
bound with your bank.
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Multisetup
A map that assigns a preset, volume, pan position and output routing to 
each of the 64 MIDI channels. Multisetups can be saved and recalled for use 
with a particular song or sequence so that all the MIDI channels play the 
proper preset. A Preset is the same as a MIDI Program.

Preset
One complete keyboard setup controlled by one MIDI channel. Presets are 
composed of multiple voices. The assignment to voices to keyboard keys is 
completely flexible.

Voice
One complete sound, containing one or more samples with keyboard and 
velocity mappings and all programmable synthesizer parameters. Voices 
can be assigned to a single note on the keyboard, or transposed to cover a 
wider keyboard range.
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Voice

Sample
An individual digital recording with a name, sample rate and loop markers.
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Preset Diagram
The diagram below illustrates the concepts of a preset and voice. 

Preset A complete keyboard layout with unlimited voices.

Voice A complete synth sound containing a single sample or a 
Multisample.

Sample An individual digital recording with loop information.
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Flexible Architecture
The EmulatorX allows you great flexibility in the way you construct presets. 
Consider this — you can assign multiple samples (multisamples) to the 
keyboard inside the voice or assign single sample voices to the keyboard.

Unless you specify otherwise, only one sample is assigned per voice. In this 
case you would assign voices (and the single sample each one contains) to 
the keyboard and create presets. On the other hand, you may want to create 
finished voices before you start designing presets and treat the voice as your 
finished sound. In this case, the preset can be used to crossfade, layer or 
switch multiple complex voices.

Voices
A voice is a complete sound that can be assigned to a range of the keyboard. 
A sample is the part of a voice that generates the actual sound. You can 
think of a voice as a complete instrument consisting of one or more 
samples which can then be used as a building block in constructing more 
complicated presets. A voice can contain a single sample or multiple 
samples, whichever you prefer.

A voice consists of one or more samples, a dynamic filter, a dynamic 
amplifier, up to three 6-stage envelope generators, up to two multi-wave 
LFOs and up to 36 modulation routings called “Cords” to connect every-
thing together.

When you record a sample into the Emulator X, a new voice is typically 
created for each new sample (recording). In this case, each sample will its 
own complete set of synthesizer parameters.

Multisample Voices
In another scenario, you might record several samples of an instrument 
(such as a piano), then place them into the same voice in order to share the 
same set of synthesizer parameters. If a voice contains more than one 
sample, this multiple sample object is called a “Multisample”. A diagram of 
a multisample voice is shown on the following page.
E-MU Systems 25



Normally these samples would be placed side by side on the keyboard as in 
the diagram above. You assign the sample to a range by setting the original 
key, (which is usually the original pitch of the sample) a high key and a low 
key. The number of samples needed for a realistic emulation varies with the 
instrument, but in general, “more is better.”

When a sample is taken, it can be automatically placed into a voice with one 
sample. You could also manually place the voice (and its sample) on the 
keyboard if you wish. If more than one voice is assigned to the same range, 
then pressing a key in that range plays all the voices assigned to that range. 
Voices assigned to the keyboard can be crossfaded by their position on the 
keyboard, or the key stroke velocity. 

S27

Multisample Voice

S28

S29

S30 S32

Positional
Crossfade

Velocity Crossfade

S31

Each Sample:
Orig. Key
Tune
Volume`
Pan
Key Range/Fades
Velo Range/Fades

Sample 28 Sample 30Sample 27
Loop, Samp Rate Loop, Samp Rate Loop, Samp Rate

Multisample voices are designed to arrange groups of samples into one manage-
able entity. The window below shows an opened multisample. The key mapping of 
the multisample overrides the key mapping of the samples contained within it.
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Voices can also be switched or faded depending on the value of a realtime 
controller such as a modulation wheel, an LFO or an envelope generator.

The Sample
Loading in any sound, in mono or stereo, creates a sample, the raw material 
with which the Emulator X works.

The term sample commonly means two different things:

• A digital recording of a complete sound, or

• Each snapshot of the sound that makes up the complete sample.

In this manual, we’ll assume sample means the complete recorded sound 
unless indicated otherwise.

You can modify a raw sample in several ways. A sample can be transposed 
up or down in pitch to cover a particular range of the keyboard making it 
unnecessary to record a sample for every key. Sample editing might consist 
of Looping a sample (allowing even short samples to play indefinitely), 
Truncating (cutting off unneeded parts of a sample), or any of a number of 
digital processes that actually change the raw sample data. 

The Original Key assignment determines the pitch at which the sample 
will be played back. Therefore it’s important to map your samples to the 
proper original key.

Original
Key

Low
Key

HighOrigLow HighOrigLow

High
Key

S02 Piano D3 S03 Piano D5S01 Piano A0

Sample Sample Sample
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TwistaLoop™
TwistaLoop is a tool that automatically analyzes any audio by dissecting it 
into its rhythmic components. This makes it easy to select multiple loop 
points and regions, and offers total control over tempo with real-time audio 
time expansion/compression.

You can playback analyzed samples in at a custom speed, or in time with 
Emulator X2’s clock (or an external clock source).

Once you create loops from an analyzed sample, you can use them in a 
variety of ways:

• Change the playback speed of any loop.

• Choose which loops are repeated when played back.

• Set up a continuous controller to change in real time which loop 
plays.

• Sync your loops to Emulator X2’s master tempo, or to an external 
tempo sources, such as a VST host.

• Play different beats or bars from the same sample.
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3 - Getting Started

Exploring the Tree
In this section you’ll learn how to navigate around Emulator X using the 
Tree. Don’t worry if you don’t what everything does just yet. Everything will 
be explained later on.

With the Emulator X application running, a bank is loaded by selecting 
Open from the File menu. The screen shown below appears.

The Tree is the section shown on the left of the screen. There are three tabs 
at the bottom of the Tree labeled Sampler, System and Library.

Sampler Allows you to see the contents of the current Emulator X bank.

System This tab gives you access to your entire computer system: PC, 
hard disks, CD-ROM drives, network, etc. Presets, Samples and 
Multisetups can be browsed, then Merged into the current Bank.

The
Tree

Sampler/System/Library Tabs

Sampler
Bank

Presets
Folder

Toolbars

Samples
Folder

Multisetup
Folder

Presets

List View

Open
Preset
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Multisetup Page
The Multisetup is the top level of the Emulator hierarchy and is the place 
where you choose and assign presets to each of the MIDI channels.

A multisetup assigns a preset, volume, pan position and output routing to 
each of the 64 MIDI channels. Multisetups can be saved and recalled for use 
with a particular song or sequence so that all the MIDI channels play the 
proper preset.

• Click on the Emulator X icon to display the Multisetup screen.

Library The Library shows you all Emulator X related files, wherever they 
may be located on hard disks, CD-ROM or network. Presets, 
Samples and Multisetups can be browsed in the Library, then 
Merged into the current Bank.
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Changing Presets
Play your MIDI keyboard and note that one of the MIDI activity LEDs 
comes on. This is the channel on which your MIDI keyboard is trans-
mitting. If you don’t see MIDI activity, check your MIDI connection and 
make sure MIDI is set up properly in the Preferences menu.

� To Audition and Select Presets

1. Click once on the Preset Select button on the channel used by your 
MIDI keyboard. The complete list of all presets in the bank appears.

2. Click once on a preset to audition it. Play your keyboard to hear it.

3. Try out a few more presets. When you find one you like, double-click 
on it to select it and return to the Multisetup screen.

4. Change the Current Preset by clicking on the number to the left of the 
preset. The number you selected turns red.

5. Play the small keyboard at the bottom of the screen. Notice that the 
MIDI Activity LED of the current preset now plays along with whatever 
sound is selected for that channel. (Your MIDI keyboard still plays on 
the channel to which it is set.)

6. Change the channel on your MIDI keyboard then play it. The 
Emulator X now plays the preset on that channel.

� Selecting Presets from the Tree

1. When you click on a preset in the tree, you have just selected it for the 
current MIDI channel. This action also calls the Preset Global page.

2. To go back to the Multisetup page and click the back arrow or click on 
the Emulator X icon at the top of the tree.

3. You can also open a preset by dragging and dropping it from the tree to 
the single channel view.

� Changing the Current MIDI Channel

1. The current MIDI channel is simply the MIDI channel you are currently 
working with. To change the current MIDI channel, click on the 
channel number in the Multisetup page. The selected channel number 
turns red.

Note also that the channel number at the bottom of the window 
changes to reflect the current channel.
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Adjusting the Controllers
Each preset has a set of 16 continuous controllers which are used to adjust 
and control the sound as you play. Your MIDI keyboard may have several 
knobs or sliders that are transmitted over MIDI. These can be used to 
control the Emulator X if you match the CC numbers your MIDI keyboard 
transmits to the same CC numbers on the Emulator X. These global settings 
are located under Options, Preferences, Controllers.

� To Modify the Sound using the Controllers

1. Play your MIDI keyboard as you adjust the controllers knobs on the 
screen. Notice that the sound changes. If the sound doesn’t change, 
make sure the current preset (red number) is the same one that your 
keyboard is playing.

2. If you have controller knobs on your MIDI keyboard and have set up 
the Controllers (Options, Preferences, Controllers) to match your 
keyboard, you can use these knobs to modify the sound. Notice that the 
screen knob follows the movement of the hardware knob.

3. Try changing the filter type. Click on the selector to the right of the filter 
name and select one of the 55 different filter types. 

4. Adjust the Tone and Presence controls while playing the keyboard to 
hear your changes.

5. Change the Volume and Pan controls for the MIDI channel you are 
using. These settings can be adjusted remotely using MIDI controller #7 
(volume) and controller #10 (pan).
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Create Your Own Custom Bank
It’s easy to create your own custom sound banks by simply “dragging and 
dropping” the presets or samples you want onto the Emulator X icon in the 
tree.

� To Create a New Custom Bank

1. Select New from the File menu. This creates a new empty bank. (You 
can also merge presets or samples into an existing bank if you wish.)

2. Select the System Tab. The Desktop icon will appear in the tree.

3. Locate the presets you wish to include in your new bank. These will be 
located in the “E-MU Systems” folder located in “Program Files” The 
included CD-ROMs contain several other great banks of sounds. Run 
the installer application on the library CDs to install these banks on 
your hard disk.

4. When you have found a preset you want to include, simply click (left 
mouse button) and drag the preset over the Emulator X icon at the 
top of the tree. The cursor changes to a plus sign as you pass over the 
icon. Release the mouse button and a pop-up progress bar will inform 
you that the preset is being loaded.

5. Continue to add presets to your new bank.

6. Save the bank when you are satisfied.

� Alternate Method using the Librarian to find Presets

1. Select the Library Tab instead of the System Tab in step 3 above.

2. If you haven’t done so already, Update the Library.

3. Choose presets from the Library.

Load a New Bank
Load up a new bank in preparation for the next few examples. Load the 
Proteus Composer X bank located in your Emulator X folder.

1. Select Open from the File menu, then locate Proteus Composer X and 
click Open.

2. That’s it!
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Opening a Preset
A preset is a complete keyboard setup for one MIDI Channel. Think of a 
preset as one complete sound containing multiple voices and samples.

1. Click on the Preset Folder in the Tree to show all the presets in the bank.

2. Click the Show Details button. The details of the presets are now 
shown. The sort buttons allow you to sort the presets by name, ID 
number, bank/program number, or category. Click on the button again 
to sort in reverse order.

3. Clicking on the plus sign (+) next to the Preset folder or double-
clicking on the folder itself opens the folder and displays the bank’s 
presets in the tree.

4. Clicking on the plus sign (+) next to one of the preset icons displays the 
sub-modules of the preset: Voices & Presets, Links, Voice Processing.

Click
Here

To Show All

Click on a
preset icon

to go to
Preset

Global

Double-click
to open the

Folder.

Sort Buttons

Show Details 
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5. Open the preset “And Voice” by clicking on the plus (+) sign next to the 
folder.

6. Next, click on the “Voices & Zones” icon. The Key Window appears. The 
blue bars show that the two multisamples in this preset are mapped 
across the entire keyboard.

7. Click on the Mix/Tune tab at the top of the window.

8. There are two multisampled voices in this preset. Adjust the volume 
slider for each of the voices as you play. Now try playing with the pan 
position and transpose. Before you leave this window, turn up the 
volume controls on both voices.

Submodule Function

Voices & 
Zones

Assign voices and multisamples to the keyboard, which can be 
switched or crossfaded by key position, velocity or controller setting.

Links Multiple presets can be layered, switched or crossfaded across the 
keyboard.

Voice 
Processing

Synthesizer voice parameters including filters, LFOs, envelopes 
and cords.
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� Exploring the Key and Velocity Windows

1. Click the Key Win tab again.

2. Click and drag the ends of the blue bars so they look something like the 
screen shown above. The settings don’t have to be exact.

3. Play the keyboard from the lowest key to the highest. Voice 1 plays at 
the low end of the keyboard and voice 2 plays on the high keys.

4. To return both voices to their original positions, select Edit, Undo from 
the toolbar. Select Undo again until both voices are assigned to the 
entire keyboard.

Velocity Switching and Crossfading

5. Click on the Vel Win tab. The following window appears:

6. This screen controls the voices using key velocity or how hard the keys 
are played. Set the bars something like the screen above.

7. Play the keyboard anywhere, but begin playing softly and gradually 
play harder. Notice that the choir (voice 2) plays with lower key 
velocity and switches to piano (voice 1) when you play hard. You’ve 
just created a velocity cross-switch.

8. Ctrl-click the end point of the bar in voice 1 and drag it to the left. The 
color intensity of the bar fades. The fade in color is analogous to 
volume. the darker the color, the louder the volume for a certain 
velocity.

9. Drag the fade points of the two voices so they look something like the 
window shown below.

Step 8. Ctrl-Click here
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10. Play the keyboard anywhere, but begin playing softly and gradually 
play harder. Notice that the choir plays with lower key velocity and 
fades into piano as you play harder. You’ve just created a velocity 
crossfade.

� Add a Voice

1. Select Preset, New Voice from the toolbar. A new, empty voice appears 
below voice two.

2. The label area of the new voice is blank. Click on the selection box to 
the right of the empty label area to bring up the entire list of samples in 
the bank.

3. Select sample 0350 SectionStringC3 by double-clicking on it. You’ve 
just assigned a sample to the voice you created.

4. Play the keyboard and now you have orchestral strings as well.

� Delete the Voice

1. Select the voice you just created by clicking once on the sample name or 
number to the left of the name. The number turns red.

2. Select Preset, Delete Voice from the toolbar. The voice has now been 
deleted.

Much More…
Now you’ve had a small taste of what you can do with the Voices and Zones 
section. Read chapter 5 of the pdf manual to learn more about the Preset 
Editor.
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Examine a Voice
Each voice has its own synthesizer section (called Voice Processing) to 
process the raw samples. You can process each voice separately or select all 
voices to be processed in the same way.

1. Go to the Tree and click on preset P0015 Dyna-heim. Play the 
keyboard. You should be able to hear the preset.

2. Open the preset by clicking on the plus (+) sign, then click on the Voice 
Processing icon.  The Voice Processing page shown below appears.

3. Near the top of the screen near the keyboard you’ll see the Group 
Selector. Set this to All, to select all voices in the preset.

4. Feel free to explore the synthesizer section. The filter section is probably 
a good place to begin. Change the filter type, then adjust the frequency 

Step 3.
Select All

Step 5
Set to LFO 1 ~

Step 6
Set to Filter Frequency
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and Q controls as you play the keyboard. Note that the filter response 
display changes as you change the filter settings.

Cords
The reason synthesizers are able to generate such complex sounds is 
because most if not all of their processes can be placed under automatic 
control. Here’s an example.

5. Tired of turning the filter frequency by hand? Let’s program one of the 
LFOs to do it. Choose Cord #8 and set the left selection box to LFO 1 ~.

6. You’ve just connected one end of a Cord. Like all cords, you’ve got to 
connect both ends for it to do anything. Connect the other end of the 
cord to Filter Frequency.

7. Each Cord has its own attenuator which controls “how much” signal 
goes through the cord. Turn the knob in the center of the cord all the 
way to the right (+100%).

8. Now set the filter frequency knob about 1/3 of the way up and play a 
note on the keyboard. You should hear the filter being turned up and 
down automatically. 

9. Change filter types and adjust the filter frequency if you don’t hear the 
filter being modulated.

10.  Adjust the Frequency of LFO 1.

11. Change the Shape of LFO 1. (You’ll have to re-key to hear the new 
waveform.)

Modulating Cords
In the Emulator X even the Cords themselves can be controlled by other 
modulation sources or controls. Let’s use your keyboard’s mod wheel to 
control the amount of LFO to filter modulation.

12. Cord 0 already has the Mod Wheel assigned as an input. Set the output 
of Cord 0 to go to Cord 8 Amount.

13. Turn up the amount of Cord 0 to 100%.

14. Set the amount of Cord 8 to 0% (off). (You’re going to turn it up with the 
mod wheel.)

15. Now play a note and move the Mod Wheel of your keyboard up. (Most 
keyboards have two wheels or controllers. One bends pitch and the other is the 
modulation wheel.)
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Experiment

16. Try setting the output of Cord 11 to Pitch. Now try changing the LFO 
Shape. Now it’s much easier to hear the different LFO wave shapes.

Wipe the Slate
The preset might be a little messed up after your experiments. It’s good to 
know that as long as you don’t Save it, none of the original data is 
destroyed. If you want to get back to the original preset, simply load the 
bank again.

You can also Undo any changes you made by repeatedly clicking the back 
arrow button (=).
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Examine the Samples
Samples are the digital recordings which are the basis of an Emulator X 
sound. As you’ve seen, samples can be layered and switched or treated by 
the Voice Processing functions to create entirely new sounds, but the actual 
samples can also be modified and sculpted.

A single preset may use over a hundred samples and a bank may contain 
thousands of individual samples. Let’s take a look.

1. Click on the plus sign (+) next to the Samples folder to open the folder 
and display the samples in the bank. (If the Preset folder is already 
open, you can click on the minus sign (-) next to the folder to close it 
and clean up the tree.)

2. Click on any sample to display its waveform.

3. The transport controls located in the toolbar display. If you don’t see 
them, right-click an empty area in the toobar and select Sample 
Transport. Click on the Play button  to listen to the sample.

Horizontal Zoom

Vertical Zoom

Zoom All
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4. Press the Stop button  to stop playing.

5. Click on the larger magnifying glass of the Horizontal Zoom buttons. 
The time-base of the waveform is magnified allowing you to see more 
detail. Continue clicking and eventually you’ll reach maximum magni-
fication. The individual sample measurements are shown here as dots. 
If the sample rate is 44.1 kHz, then there will be 44,100 of these dots 
per second of sound.

6. Click repeatedly on the smaller magnifying glass and the horizontal 
magnification decreases.

7. Click the Zoom All button, and the view zooms to show the entire 
sample.

8. The Vertical Zoom buttons allow you to zoom in or out on the vertical 
axis. Neither the vertical or horizontal zoom buttons change the wave 
in any way. They’re just display controls.
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Using DSP
There are a number of DSP or digital signal processing functions that you 
can perform on the raw samples. Samples can be spliced together, merged, 
time-stretched, reversed and on and on. 

Unlike Voices & Zones or Voice Processing functions, the DSP tools actually 
change the recorded sample data.

Time Compression/Expansion

1. Select sample Riff Trip Gb. Press Play on the transport controls to check 
it out.

2. Suppose you wanted to change the tempo to fit into your song. The 
time compression/expansion DSP tool can do this for you. Select Time 
Compress from the DSP toolbar.  The following dialog box appears.

Note: The original tempo shown may not reflect the actual tempo of the sample. 
You have to set this value manually in order to have the new tempo accurately 
calculated.

3. Change the ratio. Ratios below 100% compress or shorten the time. 
Ratios above 100% expand or lengthen the time. Note that the tempo 
and length fields change to show the new length and tempo.

4. Press OK to change the time scaling. Press Play again and note the 
change in tempo of the sample.
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Loop Play

5. Turn on Loop Play  on the Transport toolbar. Now the sample will 
continue to loop until you press Stop.

Reverse

6. Select Reverse from the toolbar.  The sample is immediately 
reversed.

7. Press Play and hear the sample played backwards.

Copy and Paste

8. Select the entire sample by pressing the Select All button  on the DSP 
toolbar.

9. Choose Copy from the Edit menu. The sample is placed on the 
clipboard.

10. Click anywhere on the waveform display to deselect the sample, then 
position the cursor at the very end of the sample by pressing the Loop 
End button in the transport controls. The flashing cursor line is now 
positioned at the end of the sample.

11. Choose Paste from the Edit menu. The following dialog box appears.

12. Insert mode is already selected and it’s the mode we want. The 
clipboard contents will be inserted at the cursor location, extending the 
length of the sample. Press OK.
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13. Now position the mouse pointer at the very end of the sample. Press the 
shift key down and click the left mouse button. The section of wave you 
just pasted is selected.

Pitch Shift

14. Select Pitch Shift from the DSP toolbar. The following dialog box 
appears.

Step 13. 
Position 
pointer here.
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15. Set the Tuning interval. 100 cents equals one semitone. Try a setting of 
700 cents or a perfect fifth.

16. Select Constant Time. This setting changes the pitch but will leave the 
rhythm constant. Don’t change the algorithm.

17. Press OK to change the pitch.

18. Click on the Loop Start button in the Transport Controls to set the 
cursor to the beginning of the sample and press Play.

Experiment!
Please feel free to try out all the other DSP processes. Be sure to read the 
Sample Edit chapter to learn all about these powerful tools, but you should 
actually try them out as you read.

Remember that nothing is made permanent until you save the bank, so 
experiment as much as you like.

Samples can also be exported as WAVE or AIFF files using the Export 
function in the Sample Edit menu. This allows you to use other sound 
processors in your computer. Externally processed samples can be re-
imported using the Import option in the File menu.

Save and Save As
When you choose “Save As” from the file menu, the entire bank—presets, 
voices and samples—are re-written to the hard disk. This method, although 
somewhat wasteful of memory, ensures that all your samples remain 
bound with your bank.

When you choose Save, (instead of Save As) only the edited presets, voices 
and samples will be written, saving time and memory.
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The Librarian
As your sample library grows so does the problem of managing all your 
banks, presets and samples. As you’ve probably already discovered, a single 
bank can contain literally thousands of individual samples.

The Library is accessed by clicking the Library tab at the bottom of the Tree. 
To use the librarian, you first “Update” from the File menu. This creates a 
searchable database of all your samples, presets, banks and audio files 
which can be quickly searched. Audio files can be either WAVE or AIFF.

You can select which drives you wish to add to the catalog or manually 
“Add Locations” to narrow down the selection range to speed the update 
process. The Add Location button also allows you to specify network drives 
to catalog. Only the selected targets are overwritten with new data when the 
update process is performed. Unselected targets remain as they were. The 
“Clear Library” button erases the entire library so you can start from scratch.

� Using the Librarian

Catalog your Disks

1. Select Update from the File menu. A popup dialog box appears asking 
you to select the disks you wish to catalog.

Update Updates the Library with the selected items, leaving non-
checked targets intact.

Clear Library Erases Library database.

Add Location Allows you to manually select targets to speed update time or 
select network drives to catalog.
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2. Select any disk drives that contains the banks, presets and samples that 
were included when you installed the Emulator X application. Using 
the Add Location button, you can select network drives to add to the 
Library catalog. The Add Location button also allows you to select 
specific folders or locations for cataloging.

3. Click the Update button to begin cataloging. The display will read: 
“Updating”. This process may take a minute or two depending on how 
many files need to be cataloged.

Find your Files

4. Select the Library tab at the bottom of the 
Tree. All Emulator X Banks, Presets, or 
Samples can now be accessed here.

Tip: You can add Category tags to your own 
presets and samples by Right-clicking on 
them.

5. Select a Category of presets from the list. 
Presets have a three-letter prefix denoting 
the type of sound. 
(bs = bass, kb = keyboard, etc.) Select Any 
to select all cataloged files.

6. Browse through the Bank, Preset, and 
Sample folders to find the sounds you 
want.

7. Click on the Bank, Preset, or Sample 
folder to view the entire folder contents.

Load your Files

8. To add a file to the bank, Left-click and 
Drag the desired Bank, Preset or Sample 
in the Library over the Emulator X icon at 
the top of the tree and release the mouse 
button. The file is added to the bank.
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Much More!
Now that you’ve had a brief tour of the Emulator X2, read the complete 
Emulator X2 pdf manual on CD-ROM to learn everything else you need to 
know. You’ve just read the first three chapters of the manual, which is 
probably enough to get you started. Have fun!

Chapter 4 - Multisetup/Global Controls - Multisetups allow you to 
store a snapshot of the current MIDI channel to Preset setup for 64 
channels.

Chapter 5 - Voices and Zones - The Preset Editor is where samples get 
assigned to the keyboard (keymaps).

Chapter 6 - Voice Processing - The Voice Editor is the synthesizer 
portion of the instrument.

Chapter 7 - Editing a Sample - The raw samples can be looped and 
modified using DSP tools.

Chapter 8 - TwistaLoop - This chapter gives you an overview TwistaLoop 
and shows you how to make multiple synchronized loops.

Chapter 9 - Effects - This chapter gives you an explanation of how to use 
the effects included with Emulator X2.

Chapter 10 - Controls - This chapter gives you an overview of all the 
Emulator X controls.

Chapter 11 - From Sample to Preset - Learn how to sample your own 
sounds and how to use the automatic sampling functions.

Chapter 12 - Synth Basics - Modulation, envelopes, LFOs, filters and 
much more are covered in this chapter about synthesizer operation.

Chapter 13 - Appendix - This chapter explains how to use the “Emulator 
File Converter” and the “Emulator X VST” application, as well as all the bits 
that didn’t fit anywhere else.
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description  19
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F
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H
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Headroom/Boost Control  12

I
IntelliEdit  13

K
Key/Velocity Windows  36
Knob Tracking  18

L
Librarian  47
Load Last Bank at Startup  17

M
MIDI

cc#7 curve  15
channel, current  31
continuus controller setup  16
controller #7  15
preferences  13
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selecting input ports  13
velocity curve  15

MIDI Response  15
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Multisetup

description  22
intro  30
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N
Network, searching with librarian
47

O
Optimizing your computer  4

P
Polyphony, optimizing  10
Preferences  7
Pre-roll  9
Preset

about  22
auditioning  31
changing  31
description  22
opening  34
selecting from the tree  31

R
Receive Program Changes  14
Recording Directory  18

S
Sample

definition  27
description  23
rate, setting  11

Save  20,  46
definition  19

Save As  20,  46
SCSI Tips  5
Select Preset on Active Channel  17
Sensitivity, MIDI controller #7  15
Software Installation  3
Streaming, description  8
System Requirements  3

T
Tempo Control, enable/disable  14
Tree, exploring  29

U
Ultra-High Prec. Interpolation  12
Update Library  47
Use Optimal Buffer Size  11

V
Velocity Curve, MIDI  15
Voice  37

add to preset  37
description  22,  25

Volume Curve  15
Volume Sensitivity  15
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